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Image of the Month “PHALAENOPSIS” © Judy Pucher

Competition Results: PHOTOGRAPHER’S CHOICE II

Congratulations to all the winners!

Intermediate: 13 entries, 52 images, 50 accepted Average score: 19.4
GOLD Judy Pucher Phalaenopsis

SILVER Nicola Bilic Drop
HM Mike Fanjoy Oh No!

HM Kent Wilson Winter

HM Nicola Bilic Takeoff
HM Michel Gagnon Icicle Works
HM Kas Stone Winter’s Claws

HM Kas Stone Snowbird

Superset: 10 entries, 40 images, 38 accepted Average score: 20.1
GOLD Judy Griffin Fence & Shadow
SILVER Julian Sale Humber Bay Poppy

HM Evelyn Saunders Whitewater Kayaker #2

HM Maggie Sale Lake of Bays Dock
HM Joe Vitale Penny

HM Maggie Sale Tree with Red Berries

HM Joe Vitale Another Stairwell

Judges: Maureen Mitchell – Toronto Guild Alec Burns Ron Manning – Mississauga CC
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SEMINAR

Getting The Best Image from Your Digital
Capture – By Mike Fanjoy

Managing and Sharing Your Images – By
Julian Sale

Both these seminars are available as downloads from
the Programs section of the ECC web site.

PEOPLE COMPETITION

Corrections:

In Viewfinder #6, the People Competition results had
two incorrect image titles:

Susan Capisi “Stairs” should have been “Emma”

Corinne Deverell “Emma” should have been “Good
Friends”. Apologies to Susan and Corinne. These
corrections have been made in the website version of
the newsletter.

Comments on the People Competition by the Editor
were included at the end the write up on PRINT
COMPETITION and should have had a separate title
PEOPLE COMPETITION. Sorry for any confusion.

Editor

NEW MEMBERS
We have 11 new members so far this season.
Welcome to:

Pat Baker (Peter Baker’s wife)
Veronica Marix
David Westlake
Dario Di Sante
Ted Graham
Catherine Guillaume Chow
Brian Miller
Cynthia Moore
Cathy Rector (Darcy’s wife)
Kent Wilson
Rita Halporn
Ian Harris

AUDIO VISUAL NIGHT
How to Make a Simple Digital Slide
Show – By Julian Sale

The entire evening was devoted to a live
demonstration of ProShow Gold Ver. 2.6 plus a
couple of shows incorporating some of the features
demonstrated. This demonstration focused on
showing people what ProShow can do rather than
providing a detailed “How To”.

A detailed step-by-step tutorial including all of the
areas covered plus some advanced areas not
mentioned during the demonstration is available on
CD from ECC for $4. This CD includes 13 relatively
short chapters of a few minutes each thus making it
easier to digest one subject at a time. In addition, the
CD includes a demo show plus, for practice purposes,
the images and sound file used to create the demo
show.

Based upon the large attendance at this meeting, it is
obvious that there is a great deal of interest in the
general public about this subject. We had 25 visitors
that evening – a new record for our club.

Since there was still some time available at the end of
the demonstration, we took the opportunity to view a
slide show from the archives which Bill Harrison has
digitized into the ProShow format. The show was
originally put together years ago by David Menzies a
former club member and is titled “Pearls of Ise
Shima”. It was a fascinating show all about how the
cultured pearl process was created. David Menzies’
voice commentary was very professional.

As a point of interest, the original slide show won the
Gold Medal for Documentaries in a PSA
International Competition.

Thanks to Bill Harrison for all the hard work he did
in scanning all the slides and putting them into the
ProShow format. Bill is leading a project to do the
same with many other club member shows from the
club archives.

PRESENTATION
Bugs & Blooms - By Don Corby

Biography – Don Corby has been a photographer
since the late 70’s. He became interested in
capturing the wonder of nature and the intricacies of
botanicals while working in a Western Ontario
Camera store.
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He enjoys landscapes but his artistic passion is macro
botanical studies. Since moving to Escarpment
country in 1992 he has enjoyed finding the hidden
treasures of native wildflowers along the trails,
beside the roads, and in our many conservation areas
that make the Escarpment indispensable.

You will find Don shooting images wandering and
crawling amongst wildflowers and native plants.
Although experimenting with various photographic
techniques, Don enjoys the challenge of capturing
nature without contrivance. His photographs
represent exactly what the camera (and Don) saw
when the shutter was released. Using a Nikon F3
with a 200mm macro lens Don takes most of his
pictures in the early morning when the light is just
right, the dew is on the plants and the air is still and
fresh.

Don is an active member of the Trillium
Photographic Club of Burlington and holds a degree
in Industrial Engineering.

Don Corby

Don’s macros were indeed truly remarkable. Most
shots were taken at flower level, a refreshing vantage
point from the top down views we often see. With
the help of his 200mm macro and his 1 inch
extension, his backgrounds were all beautifully soft
and blurred and of consistent tone – there was not a
hot spot in the entire show.

Don says he virtually always uses a tripod, a
Manfrotto which allows him to have his camera
virtually at ground level. At that level his 90 degree
finder certainly comes in handy.

Don never uses flash, but sometimes uses a reflector
and polarizing filter. Don frequently uses the
preview in his camera to help see what the film will
see. He always uses manual focus and focuses
through the whole range of focus to select the
optimum look to the image.

Don also shared with us a lovely show of extreme
macro shots which were generally abstract in nature
with an emphasis on colour and shapes. He uses a 2
in extension on a 50mm macro lens for this shooting.

Don achieves focus using a number of different
techniques including shifting the tripod rod and
moving the flower (if in a jar). He only occasionally
uses a moveable plate.

Don shoots almost exclusively Fuji Provia 100.

Editor

Don’s presentations included some excellent images
of insects and flowers taken with specialized
equipment. His style of macro photography helped to
isolate these subjects from their backgrounds and
make their features stand out

Don shared his specialized techniques with helpful
explanations:

For example, he often uses a 16 inch working
distance; he uses a self-timer to reduce camera shake,
because a cable release “gets lost in the weeds”; he
makes use of Depth of Field preview to understand
what subject matter is in focus; he suggests that F11
is a good working lens aperture for macro work; he
warns to “watch out for wind” because it will shake
the subjects; he notes that a macro focusing plate is
awkward to use.

Don tends to use the following equipment:

Nikon F2 and Nikon F3 camera bodies, a Nikon
200mm macro lens with a 1 inch extension tube, and
a Nikon 50mm F1.4 lens with a 2 inch extension
tube, usually with Fuji Provia slide film.

His slide show called “Skewed” showed very
interesting high-magnification macro-style photos
taken with his 50mm lens and tube. The music was
quite nice and was by Patricia Barber.

Brian Miller

PRESENTATION

France / My Garden / French Signs

By Merle Soucie – Trillium CC
Biography – I received my first box camera as a
teenager and documented high school activities.

I photographed my kids a lot and then my
photographic activities slowed down until I joint the
Trillium CC about 15 years ago.

Since then I have traveled and photographed in
several European countries, especially France,
focusing on cathedrals and other historic buildings.

I also like gardening and of course do a lot of
photographing in my garden.

Merle Soucie

Merle’s first show started off in France. With the
combination of Merle’s images of windows, food,
and old buildings set to the music of Edith Piaf, the
show certainly had a very French atmosphere.
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Moving on to churches and cathedrals of France and
other European countries was complemented with
some lovely organ music and many majestic stained
glass windows.

Merle often overcame some of the architectural
parallax challenges when photographing such large
buildings by getting in very close and looking up. An
interesting perspective.

We were then treated to a show entirely made of
images from Merle’s garden. What a prolific
gardener she must be since we saw a huge range of
interesting and lovely flowers.

Finally Merle treated us to a short show composed
entirely of French shop signs. What an interesting
and creative subject. Many of the signs were very
ornate and an art form in themselves.

Editor

One of Merle’s presentations included many fine
images created in various European countries,
including Austria, Belgium, England, Italy, and
Scotland.

The wide variety of subject matter, including people
and places, helped to vividly give the sense of
visiting these countries.

There were some beautiful images, taken with weak
perspective, that were well-suited for examples of
conservative church architecture (possibly Austrian),
located in the mountains.

One of Merle’s other presentations presented striking
images of the floral life in her garden, with intense
colours.

Brian Miller

JUDGING - PHOTOGRAPHER’S
CHOICE II – 27 MARCH

Here are some point form comments noted during the
judging.

 The judges were consistently looking for
focus, sharpness and depth-of-field

 Some digital images were obviously
scanned from a slide with rounded corners
which were cropped out on one side but not
the other side of the image – little things like
that really seem to bother the judges,
especially when it is so easy to correct with
digital images.

The moral of this point is that judges are less
forgiving with minor flaws in digital images
than with analog images simply because
such flaws are so easy to correct digitally.

Examples of easy things to fix digitally:

o Parallax, straightening, hot spots,
cropping (composition), saturation
(more or less), brightness and
contrast, dirt / scratches from
scanned slides, and rounded
corners from scanned slides.

 With several images it was hard to see the
edge of the image which seemed to blend
into the grey/black background of the
screen. The judges commented several
times that such images would benefit from a
small border. Want proof that it makes a
difference – the judges awarded a “Gold”
and “Image of the Month” to Judy Pucher’s
flower and said that the border really helped
to set off the beautiful flower.

 See the Other News/Websites/Tips section
at the end of the newsletter for info on how
to create borders with Photoshop.

 Most judges seem to prefer simple
uncluttered images.

 If you are submitting images with someone
else’s art as the centre of interest of your
image, then you are obliged to ensure that it
shows off the work of art well – in other
words, judges might be especially critical
with such images if it is anything less then
perfect.

 High contrast images do not seem to project
well. We had a couple of examples in this
judging where the dark areas in the image
had lots of detail when viewed on the
computer screen, virtually no detail when
projected.

An example of this was Alec Monro’s image
of a sunset with trees silhouetted and 3
benches in the foreground leading you into
the image. As projected, there was virtually
no detail in the foreground other than the 3
benches. The judges really liked the
composition of this image and would have
scored it higher if they could have seen more
detail in the foreground. On the computer
screen there was lots of foreground detail
and it was indeed a beautiful image. Until
project technologies improve further, it is
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best not to enter very high contrast images in
the digital competitions. It is very difficult,
if not impossible; to use Photoshop to fix
such images enough to make them look
good with digital projection.

 With a few images the judges seemed to be
second guessing what the maker was trying
to do digitally. If you add an object to an
image, make sure that scale and such detail
as shadows are realistic. If they are not,
your score will likely suffer. Digital
manipulation should either be so noticeable
that it is clear what the maker has in mind,
or so subtle that they are noticeable enough
to cause second guessing.

 If you enter an image with animals (cats,
dogs, etc) you could gain or lose in you
score depending upon the personal likes or
dislikes of the judges. Although judges are
supposed to eliminate such biases from their
scores, one judge did admit that it is almost
impossible to do.

MEMBER SHOW - By Ernest Mahrle
Ernest has been a member of
ECC since 1974 and this
was the first show that he
has put on. It was certainly
worth the wait! Let’s hope
that it won’t be another 32
years before the next one.
Ernest shared with us some
very beautiful images of
nature – early morning mist
and frost, a large selection of

wildflowers and butterflies, plus wonderful fall
colours, and amazing ice shapes on the shores of
Lake Ontario.

Ernest does not own a
computer and thus is not into
digital imaging. His show
was produced on a single
slide projector and yet it still
captivated and pleased
everyone. It is a reminder to
all of us, that at the end of the
day, it is the beauty of the
images that really counts.
Hopefully this will encourage
those who feel a little overwhelmed with all this new
technology to share your images too.

Most of Ernest’s
photography is in
and around the
Toronto area
although some fall
colours are from the
Bracebridge area. It
proves that one does

not have to go far a-field in order to find great
photographic opportunities. However, one does have
to get up early in order to
capture many of the images
that Ernest shared with us.
His spider wed shots
dripping with dew in the
soft early morning light
were fantastic.
Interestingly he says he
hand holds his camera for
the butterfly shots since
they generally don’t hang
around long enough to set
up a tripod.

Over the years he has shot with Kodachrome and Fuji
Velvia 50 and more recently Velvia 100.

Editor

APRIL / MAY SCHEDULE OF
MEETINGS

APRIL 2006

3 Salon: PHOTOGRAPHER’S CHOICE #2
Member’s Show - The Four Seasons - Ernest

Mahrle

10 $# Presentation: A Very Special Evening by
Margarete Brunner – Margarete Brunner,
Toronto CC

17 Easter – No Meeting

22 Outing: Leslie Street Spit

24 Seminar: Landscape Photography and Other
Photo Essays – Christopher Siou

Please Note: This is a program change.
Anyone who has seen Christopher’s work will
know how stunning his images and his shows
are. This is a seminar not to be missed!

MAY 2006

1 Member Photo Essay Evening

15 Annual Banquet Canadiana Restaurant –
Six Points Plaza
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OTHER NEWS / WEB SITES / TIPS

1. Program Survey – Everyone has been sent a
survey about the content of our meetings. Here
is your chance to influence how our future
programs will be put together. For example, do
you want more or less emphasis on digital
imaging, presentations, seminars, etc? Please fill
out this survey, either by downloading the Word
document and filling it out and returning it
electronically to info@etobicokecameraclub.org
or by printing it out and bringing it to a future
meeting. Your response is important and
required by 01 May 2006 at the latest.

2. Outlings – Note from the editor – I have not
been getting any images from our outings. For
those who attended, please check your files and
send along a couple, especially any showing club
members.

Bill Harrison is the current keeper of the past
outings archive and we want to add to that. The
focus of this archive is images showing club
members in action (photographing, enjoying a
tea, etc).

Please send images with Subject: Outing
Images to digsig@etobicokecmaraclub.org with
a note of which outing it is.

3. Member Web Site Link. Check out member
Alan McCord’s lovely new web site at
http://www.alanmaccord.com

4. Year End Image of the Year Competition –
Please submit your images by April 10th at the
latest. You can submit all ribbon winners from
the 6 regular competitions plus 2 other images
from the 6 regular competitions which scored 18
or more. If you did not win any ribbons, you can
still submit the 2 images which scored 18 or
more. As you know, images which did not do
particularly well in one competition can often
become ribbon winners in another competition,
so don’t hesitate to enter.

5. On Thurs, Fri, Sat, April 6 – 8 and now
extended to Sun April 9, Toronto Camera Club
are hosting a spectacular and exotic multi-media
travel presentation called “The Spirit of Asia”
by Ray and Mary Ann Anderson. Details and
tickets ($10 / $8 senior) available via
www.torontocameraclub.com Anyone who has
attended on of Ray & Mary Ann’s presentations
at our club, know that it will indeed be
spectacular.

6. On Saturday April 22 Latow Photographers
Guild is hosting a one day George Lepp seminar
– registration $75. Also that evening, Latow is
hosting an AV Festival and tickets are only $10
– an opportunity to see some great slideshows.
Details and tickets available at www.latow.com

7. July 14 – 16 is the annual CAPA Canadian
Camera Conference and this year it is being held
in Toronto. This is your chance to see and hear
some of the best photographers in Canada.
Details available on www.capacanada.ca

8. Creating a border with Photoshop:

a. Start Photoshop and open the image that you want
to add a border to.

b. To create a border around the entire picture, open
the Select menu and choose Select All. To create a
border around a certain section, use the Selection
tool in the toolbar and select the area you want.

c. From the Select menu, choose Modify and then
Border. In the dialog box, choose the pixel size of
your border.

d. Locate the color palette on the left-hand side of
the screen. Click on the top square and select a
border color from the palette. Click OK.

e. Select Fill from the Edit menu. In the dialog box,
choose the options to apply to the border.

f. Click OK to view the border. If the results aren't
what you want, select Undo from the Edit menu to
remove the fill, then try again.

g. Use the Save As command in the File menu to
save the new picture.

Other imaging editors probably have a similar
function. You will have to check their help
section for details. (PS. Picasa cannot add
borders to your images).

9. Tickets for our Annual Banquet on May 15 th are
available from Doug Satchwell / Peter Baker at
our meetings – only $30 per ticket for a great
meal and enjoyable evening. If you are not able
to attend one of the three remaining meetings
before the Banquet, please contact Doug / Peter
to arrange for your ticket(s). Guests are
welcome to join us at the banquet at the same
$30 per ticket price – it will be fun evening for
all. Many door prizes!!!

mailto:info@etobicokecameraclub.org
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